# Table of Contents

Before You Begin .............................................................................................................. 2
Starting an Analysis ........................................................................................................... 2
Address Verification .......................................................................................................... 3
Order Confirmation ............................................................................................................. 5
Overview of Drop Down Menu Bar .................................................................................. 6
Overview of the Analytic Process ..................................................................................... 7
Process Tab 1: Subject ........................................................................................................ 8
Process Tab 2: Data Import ................................................................................................ 9
Process Tab 2: Data Import, Define Market Area (optional) ............................................. 13
Process Tab 2: Data Import, Location Map ....................................................................... 15
Comp Selection: MLS Data grid ........................................................................................ 15
Process Tab 3: Comp Selection: Ranking Preferences ...................................................... 16
Process Tab 3: Comp Selection – Filters tab .................................................................... 18
Process Tab 3: Comp Selection: Property Details (Optional) ........................................... 20
Process Tab 4: Analysis ..................................................................................................... 21
Process Tab 4: Analysis - Overall Market tab ................................................................... 22
Process Tab 4: Analysis - Regression tab ......................................................................... 23
Process Tab 4: Analysis - Regression tab (Continued) ..................................................... 24
Process Tab 4: Analysis, Subject Market – Trends tab .................................................... 27
Process Tab 4: Analysis – Adjustments tab ..................................................................... 28
Process Tab 4: Analysis, Adjustments tab – Time Adjustments ...................................... 29
Process Tab 5: Value Indicators ....................................................................................... 30
Process Tab 6: Reports ...................................................................................................... 31
Page 1: Market Area Statistics ........................................................................................ 32
Page 2: Market Characteristics ......................................................................................... 33
Page 3: Comparable Sales Selection ................................................................................. 34
Page 4: Market Adjustment Factors ................................................................................. 35
Page 5: Market Conditions Addendum 1004 MC ............................................................ 36
Page 6: Market Tends ....................................................................................................... 37
Transferring Redstone Analysis into your 1004 or 2055 as Addendum Pages ............. 38
ClickFORMS Users ......................................................................................................... 38
Other Appraisal software: (PDF Creation) ................................................................. 39
Redstone Files and Where They Are Stored ................................................................. 40
Before You Begin
Refer to the **Getting Started with Redstone** page under the Support tab on the AppraisalWorld website located at [www.AppraisalWorld.com](http://www.AppraisalWorld.com).

Once the startup tasks are completed, it is advisable to complete a couple of tutorial analyses before completing an actual analysis. To access the Practice Tutorials, go to **Tutorials -> Practice Properties**.

**Note:** To Create a **Redstone** Analysis:
- A credit card **must** be on file in your AppraisalWorld My Office account.  
  AND YOU MAY ALSO
- Purchase a 10 pack of **Redstone** Analyses from the AppraisalWorld Store.

**Starting an Analysis**
Open **Redstone** and select **New Analysis** under the **File** drop down menu.

You will be asked to login to create the account. Use the same password that is used to login to your AppraisalWorld account.

**Suggestion:** **Starting with the end in mind, you may want to review the report pages near the end of this document.**

**Note:** If the login does not work and you get an error, you may need to link the **Redstone** application to your AppraisalWorld account. This can be accomplished by accessing **Appraiser Setup** under the **Help** dropdown Menu. Follow the prompts to completion.
Address Verification
The first window to appear is Address Verification

The following steps and options are available:

a. Enter the Subject Property address.
b. Click the Locate and Verify Address button (you may have to manually move the Subject marker to the correct location. Left click and drag the Subject marker to the correct location and place it on the center of the subject property home).
c. Displays the verified address that will be used within the report.
d. Click Show Birds Eye View to display (where available) a 45% view of the property.
e. The navigation tools within the Birds Eye View and Ariel View can be used to zoom in “+” and out “−”. Birds Eye view has the added ability to use the curved arrow keys to the left and right of the compass to rotate the Subject property.
f. Independent will appear here for the Redstone Reports you create and for actual reports you create.
g. Reference Numbers.
h. Enter the Effective Date of the Appraisal.
i. Select Desired Report (more reports may be added to Redstone in the future).
j. Click the Start Analysis button to continue.

Note: If the Start Analysis button is greyed out, your address did not verify. Check the box in front of Address Verification on the left side of the window to activate the Start Analysis button.
Order Confirmation

If the Address, and/or Report Type are incorrect, click **No** and go back to the Address Verification window to make your corrections.

Once all information is correct, click the **Yes, Authorize Charge** button again and credit/debit card is billed.
Overview of Drop Down Menu Bar

Below are the options available under the primary drop down menus. For the sake of time, most are typical and will not be covered here.

![Redstone drop down menu bar](image)

Important Menu Options:

- **a.** Edit: Copy Redstone Analysis copies report pages onto the clipboard for import into ClickFORMS (exclusively for ClickFORMS users). For those who use other form filler software, simply add a PDF of the Redstone Addendum to your report.
- **b.** Orders: Links to the AppraisalWorld Order Manager.
- **c.** Window: Display multiple Redstone Analyses as a Cascade, Tile Vertically and Tile Horizontally.
- **d.** Help: To Check What’s New for recent enhancements, fixes and current issues.
- **e.** Help: To access this User Guide (This document).
- **f.** Help: To access the Regression Overview (Step-by-step walkthrough of Regression).
- **g.** Help: Request Support opens a window for forwarding a support request.
- **h.** Help: Send a Suggestion opens a window for forwarding a suggestion to the Product Manager.
- **i.** Help: Download TeamViewer will transfer you to the TeamViewer download link if remote access is requested by tech support.
- **j.** Help: AppraisalWorld opens the AppraisalWorld website within your default web browser.
- **k.** Help: Appraiser Setup opens the Appraiser’s AppraisalWorld user profile for editing Appraiser profile information.
- **l.** Help: About Redstone opens a window and displays the current version and release date.
- **m.** Tutorials: Practice Properties opens the tutorial selection window.
- **n.** Tutorials: Check MLS Data Import opens a tool to check an MLS import for missing data fields.
- **o.** Tutorials: Guide to How to Test your MLS Data Import for missing fields.
Overview of the Analytic Process

There are five main steps in completing a Redstone Analysis:

1. **Subject**: Entry and verification of the Subject Property information. This information comes from public data records and can be edited as needed. Here you’ll also find a Location and View influence map to assist in identifying any external factors surrounding the subject property.

2. **Data Import**: Import MLS data, review and edit property data.
   - Sales and Listings Distribution displays where the subject lies in the market based on characteristics.

3. **Comp Selection**: Use neighborhood boundaries, feature ratings and filters to identify the properties that are most comparable to the subject property.

4. **Analysis**:
   - **Overall Market** data analysis.
   - **Regression** analysis of the included sales to help determine adjustments.
   - **Subject Market Trends** for the 1004MC report page.
   - **Adjustments** (The adjustments do not transfer into ClickFORMS. The Adjustments will be used during the creation of appraisal reports to be included in future Redstone releases).

5. **Value Indicators**: Compare your Value Estimate with the Regression Analysis and other sources to determine if your Value Estimate is higher or lower compared to the other available resources.

Process Tab 1: Subject

The **Subject** tab provides you with the opportunity to verify and edit the subject property data brought in from public records.

a. The Address and geo code is shown here and cannot be changed once the order has been submitted.
b. Enter a **numeric** value for these “**Component of Value**” fields. This data will be used within the Regression Analysis and the filtering of comparables under the Analysis Tab.
c. The Location and View Influence selected on this window will transfer into **ClickFORMS** and **Redstone UAD** report forms. These fields may appear in various other **Redstone Reports**.
d. This map provides you an image of the area surrounding your subject property. This will assist you in identifying any external factors surrounding the subject property.
e. Use the Navigation Tools to navigate the map image. If your mouse has a roller, you may use it to zoom in and zoom out on the image.

The fields highlighted in **green** do not display in the **Redstone Analysis**. They do transfer into **ClickFORMS**.  
**Note:** These fields may also be included in other **Redstone Reports** to be included in future Redstone releases. **Non-ClickFORMS** users can use these fields for **reference**.
Process Tab 2: Data Import
This section provides for importing the MLS Sales and Listings file you create within your MLS into Redstone.

We will divide the two processes taking place under the Data Import tab: **MLS Import** and **Define Market Area**. The **MLS Import process:**

Import your local MLS data into Redstone and review for data errors.

1. Click the **Import MLS** button.
2. In the Import MLS Data File window select your MLS System State.
3. Select your MLS System Name. Redstone remembers your last selection.
4. Select **SFR** or **Condo** radio button depending on what type of property you are analyzing.
5. On the lower left side of the window, click the “Add MLS name to Data Source field” checkbox.
6. Click the **Browse** button to locate your MLS data file. Once you select the data file, you will see the name of the file in the **Data file exported from MLS System** field.

**Note:** The data import will automatically begin once the file is selected without having to click the **Import MLS** button.

7. The Number of **Errors** and the Number of **Duplicates** are shown to the right of the **Import MLS** button.
8. **Fine Next Error** button opens a dialog box for correcting MLS data errors. It will be covered in the next page. Check the box to display the **Comments** column below.
9. **Exclude Duplicates** removes the most likely duplicate highlighted properties (if you prefer, you may also review them and manually select which property to remove).
10. **Delete Excluded** removes all excluded properties and Excluded Outliers from file permanently.
11. Displays the number of Imported Sales, Imported Listings, Excluded and Remaining.
12. **Export Data** is an **optional** function to export the cleaned MLS data to a separate comma separated value (.csv) data file.
MLS Data Verification

This message below will appear if the subject property is included within the MLS data import. The appraiser has the option of removing the subject property, highlighted in red, from the MLS import within the MLS Data Verification window.

You have the option of scrolling through the properties and uncheck the Subject Property to remove it from consideration.
MLS Data Verification

Find Next Error function provides options for reviewing and correcting imported MLS data.

![MLS Data Verification Window]

- **Yellow highlighted** data is the data currently presented for verification.
- **Red highlighted** data fields are those fields that will need verification.
- **MLS Data Verification** window provides multiple options for correcting or bypassing the data issue.
- The address of the property address that contains the data issue.
- The column header that contains the data issue. For example, Garage Cars.
- Display area for the data issue to be resolved.
- Enter the correct value in the New Value field.
- Check/uncheck to save/not save your edits for automatic use for future data imports.
- **Replace** the data displayed in area f with the information displayed in h.
- **Replace All** the data errors with the data displayed in area f in the column e with the information displayed in h.
- **Skip** the specific data error displayed in f for the property d.
- **Skip Column** ignores all data errors for the column e.
- **Exclude Property** removes the property from the data to be transferred into the analysis. If you decide to exclude a property from the analysis, be sure that it is not a potential comparable.
- **Cancel** stops the data review process and returns you to the Data Verification window. The process can be resumed by clicking the Find Next Error button.

**Note:** Use caution in making corrections as corrections to Fireplaces, Garages, Carports, Pools and Spas are recorded. When the same unrecognized entry is encountered again, your previous correction will be used to replace the unrecognized entry.
MLS Data Verification - MLS Automatic Changes Review

When you are ready to import by clicking **Save and Close**, you will be given the option to review and confirm the edits. You can edit the information in the New Value column if needed, then click the OK button.
Process Tab 2: Data Import, Define Market Area (optional)

Creating a Market Map Area Map is an optional Process.

The following buttons and information is shown on the right side of the Data Import window:

n. **Define Market Area** opens the Market Library.

o. **Refresh Map** is self-explanatory.

p. **Sales and Listing Outliers** indicates the number of properties that lie outside the Market Area.

q. **Map Legend** defines the property indicators on the map.

r. **Exclude Outliers** opens a dialogue box like the one shown below for selecting Sales and/or Listings to be excluded from consideration within the analysis.

![Exclude Outliers Dialogue Box](image)

s. **Sales Distribution** provides graphic information of the distribution of sales within the market area in comparison to the subject property.

t. **Listing Distribution** provides graphic information of the distribution of listings within the market area in comparison to the subject property.

Market Distribution shows the distribution of the Sales and Listings across various Market Characteristics including: Sales Price, Listing Price, GLA, Age, Site Area, Basement Area, Basement Finished, Bedrooms, Total Baths, Fireplaces and Car Storage.
a. If you have previously created a market boundary for a property near your current Subject, Redstone will select that previously defined boundary for you. If there are more than one previously created boundary maps, Redstone will alert you to the number of maps. You may select one of the maps by double clicking the desired map in the Map Library. This will transfer the map and close the Market Library window.

b. Click the New Map Button to create a new neighborhood boundary map.

c. Left click the mouse button and Release to set the first point of the boundary. Continue the process to set points around the boundary. Double click the last point to stop the process.

d. Once completed, any of the corner edit points can be moved. Hover the cursor over a point and when the cursor turns into a finger, click, hold and move the point to the desired location. Two additional target points will appear, one on each side of the moved point, providing additional adjustment options.

e. If you make a mistake and need to start over, click the Clear button and redraw your boundary.

f. When complete, enter a Name in the space provided and click the Save to Database button.

g. The Center button centers the current map with the Subject Property at the middle.

h. The Edit button allows you to edit the map currently displayed. As you roll the mouse over the shaded area, the map boundary becomes bold. Click the shaded area and the edit corner points are displayed. To complete the editing process, click the Edit button. The edited map can replace the current map or as a new map. Be sure to enter a new name in the Name field provided before clicking the Save to Database button.

i. Click the Transfer Map button to transfer the map displayed to the analysis and close the Market Library window.

j. To leave the screen and abort any changes made, click the X in the upper left hand corner.
Process Tab 2: Data Import, Location Map

The Market Boundary Map is shown on both the Data Import and Comp Selection. Based on if you are in the Sales or Listings tab, the corresponding dots will show on the map. Note the following:

- **Rank** sorts the sales and listings by their Rank order.
- **Hide Map** clears the map on the left side of the window allowing more room for the Sales and Listings.
- **Show Ranking Preference** hides the Map and brings up the Ranking and Filters functions shown in the following pages.
- **Map Legend** defines the property indicators on the map.
- The Red dot is the Subject Property.
- A single click on a dot on the map or on a property address line (on the left):
  - Gold highlights the corresponding property.
  - Gold dot indicates the corresponding property location on the map.
- The legend shows the Property Type for each color dot displayed on the map.

Comp Selection: MLS Data grid

The Comp Selection tab is separated into two sections; Sales and Listings.

If you do not want a particular property to be considered as a comparable or for further analysis of the market, you may manually exclude it by unchecking the box in the Include column:

**Note:** Clicking the column header of any column will sort the properties from either high to low or low to high based on the data contained within that column.
Process Tab 3: Comp Selection: Ranking Preferences

To assist you in the selection of comparable properties in relationship to the subject properties, it is necessary to set the Ranking Preferences and Filters. BOTH Sales and Listings are Ranked and Filtered at the same time.

Feature Rating is the process used to bring the most likely Sales and Listings comparables to the top of the list. The Sales and the Listings are now ranked and filtered at the same time.

Moving the slide bars dynamically changes the Rank for the corresponding column. The final Rank Score (d) is calculated by adding the Near Score (a) + the Match Score (b) + the Weight Score. An automated value is added to a Comp when a Comp # is set for the property. The added value moves the Comp to the top of the list. This only occurs when a Comp # is set for a property. The added value is taken away if the Comp # is removed from the Comp reverting back to its original Rank.

a. The Near score combines the ratings for Proximity and (Date of Sale for Sales and Listing Date for Listing Comps) and is highlighted in blue on the right side of the window. Moving the sliders increases and decreases the significance of each of the characteristics displayed.
b. The Match score is a combined rating of characteristics and is highlighted in yellow.
c. Click the v to the right of the blank in the first column to select and enter the comp number for the
d. Properties highlighted in blue are the properties removed using the filters or deselected from the list of potential comps.

The Feature Rating and Filter settings will be saved with the report. The Feature Rating settings will be used the next time the Redstone report is opened.
Note: The Near Score for Date of Sale is determined by how long ago the sale was completed. High is closer to the Effective Date, Low is further from the Effective Date. Same concept applies to Listing Date; High is closer to the Effective Date, Low is further from the Effective Date.

Appraisers are advised to check and verify the settings during the selection of comparable properties for each Redstone report as the previous settings will be used to automatically sort the Sales and Listings.
Filters remove properties (the less likely comparable prospects) leaving the most likely comparables for consideration. Your local knowledge of the market area is vital in guiding the filtering process.

- Indicates the **total** number of sales and listings, number **excluded** and number **remaining**.
- The **Subject Property** data is shown in the middle columns and the **Minimum** and **Maximum** indicates the highest and lowest value within the database.
- Clicking the arrow next to the box lists the available filter types. Select the filter and appropriate boxes will show up in area (e). Filters include:
  - Filter Off
  - Less Than
  - Equal To
  - Greater Than
  - Between (See **Note** on bottom of next 18)
- Click the **Apply Filters** button after setting each filter and view area (a) to verify the number of properties remaining for use within the report.
- Click the **Reset** button to set all Filters Off.
- Type in the number for high and low. Use the up and down arrows for fine tuning. If too many properties are excluded, you can widen the parameter by using the up and down arrows. Click on **Apply Filters** (b) and all the properties are filtered based on the new criteria.
Here, additional filters were used to narrow the list of Sold and Listed properties to a manageable size. We suggest that you Apply each filter before proceeding to the next filter.

The filters applied in this example will limit properties to those Less Than 1.0 miles of the subject property, sold or listed Less Than 180 days, with Gross Living Area Between 1800 and 2600 sq. ft. and Equal to 1 story.

As each filter is applied, you have the option of expanding or contracting previously applied filters on this screen.

a. Click the Show/Hide Ranking Preferences button and the Show/Hid Map to fully show the work area and Click the desired Sales/Listings tab.

b. Adjust the desired Filters to refine the list of available Sales and Listings.

c. Click on the Down Arrow and select the Comp number for the selected property. To Clear the selection, open the drop down box and select Clear to remove the number from the selected property.

d. Uncheck the checkbox to remove a property from consideration as a possible comparable. Click Rank to move the property below the list of considered properties.

Numbered Sales Comparable, Feature Ranking and Filter settings will be shown on the the third page of the report, Comparable Sales Selection Methodology.

Note: The Filter settings used to identify comparable, will be forwarded and used to identify properties for the 1004MC. Adjust the filters under the Comparable Properties tab to increase or decrease the list of properties to be included in the 1004MC.
Process Tab 3: Comp Selection: Property Details (Optional)

The Property Function provides detailed MLS information comparing the potential comparable property side-by-side with the subject property.

- **Double clicking** a property address brings up a window displaying additional data you imported from your MLS.
- **Click** the **Prev** and **Next** buttons to advance to the next comparable or go back to the previous comparable.
- The appraiser can make corrections to the comparable property data. **Click** the **Update** button to save the changes before leaving the Property detail window for the edited property.
- **Click** the **Close** button to close the Property Detail window and return to the Comp Selection window.

**Note:** If the comps are sorted by address or other field to locate a comp, and the comp is not currently selected (highlighted in blue):

1. Check the check box to include
2. Click the Rank button
3. Locate the property and assign a comp number to the property.
Process Tab 4: Analysis

In the Analysis tab, you will be able to use Regression, Ranking and Filters to process the data. At the end of the process you will have many of the **components of value adjustments** derived from the Regression Analysis. You will also have a report page that documents your weighing and filtering of the available comparable. The **1004MC** data is analyzed and displayed in the 1004MC form under the Report tab.

Below is an overview of the various operations available under the Analysis process tab.

![Analysis Tab Overview]

a. **Overall Market** breaks down monthly statistics for all the sales and listings imported into the analysis and an overview is displayed on the first page of the report, the Market Summary.

b. **Regression** calculates adjustment ranges for various components of value and forwards the adjustment ranges to the fourth page of the report, Market Adjustment Factors.

   **Note:** Those components of value with a p-value of less than **0.05000** are considered statistically significant and may be forwarded to the Market Adjustment Factors report page if you opt to do so. There is a checkbox on the Regression tab that allows you to send all components or only those with a p-value of less than **0.05000**. The closer the value is to 0.00000, the higher the statistical significance of the Most Probable Value and the adjustment range.

c. **Subject Market** provides filters that reduce the list of properties to meet the requirements of the 1004MC and the resulting data is forwarded to the fifth page of the report, the FNMA 1004MC.

d. **Adjustments** document the components of value for use in the valuation sales grid.

   A number of options for calculating **Time Adjustments** have been added under this tab and will be covered in detail.

   **Note:** Non ClickFORMS users may want to select a Time Adjustment option for calculating time adjustments for the Sales Comps that will appear on the Adjustment Factors page of the report.

The remainder of the information under this tab is **For Reference Only**.
Process Tab 4: Analysis - Overall Market tab

The chart and graphs shown below pertain to the total properties brought into Redstone. This information is to help you to view the overall market as compared to the limited data used for the 1004MC. The information shown on the Market Summary, page one of the report, comes from the information shown here.

- **Detailed Market Analysis**: Each line item is also shown as a graph below.
- **Use the scroll bar on the right of the window to view each of the graphs that illustrate each line of the Market Analysis.**
- **Check this box to Treat Pending Sales as Settled Sales.**
- **You may select trend lines for, the last 12, 6 or 3 months to assist you as you interpret the data. Here you can determine if the trend is increasing, decreasing or stable.**
A preliminary analysis has been run against the data and outlying properties were removed from the list of available properties. The properties are listed to the left with the removed properties unchecked and highlighted in blue.

- Indicates the total number of sales and the remaining number after exclusion of the outliers.
- Press the Run Analysis button after a line item has been removed from the list in area f (See Note below).
- The Subject Property Indicated Sale Price by Regression:
  - It is shown here for your reference only and is NOT shown within the report.
  - This is a baseline value and ranges from the amount shown plus or minus the standard error. For example, if the value shown is $100,000 and the standard error is 10% or $10,000. Then the baseline value plus or minus the standard error ranges from $90,000 to $110,000.
  - Regression does NOT predict value. It is setting a baseline value based upon the others sales within the selected neighborhood.
  - The subject properties location, view, condition and quality are not factored into the analysis.
  - As the analysis is based on sales for the past year, an increasing or decreasing market will affect the indicated value of the subject property.
- A scatter-plot showing the point where each property included in the analysis falls on the graph based upon its Actual Sales Price and Predicted Value from regression.
  - Actual Sales Price is the horizontal X-axis and Predicted Value is the vertical Y-axis.

Note: Pressing the <CTRL> key on your keyboard and clicking the Run Analysis button at the same time will apply the currently checked components of value to All the available properties and automatically remove outliers. This is a reset of the automatic removal of outliers using a consistent methodology.
e. There are two actions that will result in a distribution of properties that will resemble a bell curve within a regression:
   - The initial number of properties included within the regression analysis without using constraints (size, age, price and configuration).
   - The removal of outliers (properties whose predicted accuracy are +/- a significant percentage from 100% accuracy).

f. The list of the **Components of Value**, variables, showing **Most Probable Value, Probable Value Range, P-value** and check boxes for excluding specific variables.
   - The components of value with inflated value or high **p-values** may be removed from the analysis.
   - **Components of Value** highlighted in yellow may be indicating a negative value.
   - **Year Built** should be a negative value.
   - The **Sale Date** value may be negative or positive depending on the market.
   - The other components of value typically are a positive value.

g. Display of the **Confidence level** of the Statistical Measures.

h. Properties displayed in blue are outliers removed from the Regression Analysis.

i. Removing the Checkmark in the Checkbox allows all of the values listed on the left to be transferred. Remove any adjustments that you do not want to have displayed on the Adjustment Factors Report page.
   This option has been added as requested by appraisers. Redstone’s default setting **ONLY** display components of value with a **p-value** of less than 0.05000 to be considered statistically significant and forwarded to the Adjustment Factors report page. The closer the value is to 0.00000, the higher the statistical significance of the Most Probable Value and the adjustment range.

**Note:** A Regression Overview document containing information on how to refine your analysis is available under Redstone’s Help dropdown menu.
Note: The Filter settings used to identify comparable, are shown and are used to identify properties for the 1004MC. Adjust the filters to increase or decrease the list of properties to be included in the 1004MC.

**The Comp Selection filtering is forwarded to this tab.** The Sales and Listing comparable shown are the same as those used for Comp Selection. Adjust the filters to broaden the number of properties to be included in the 1004MC.

This process provides filters for reducing the list to include only those properties needed for the completion of the 1004MC.

- Running totals showing the total number of sales and listings, number excluded and number remaining.
- Displays the Subject Property data in the middle columns and the Minimum and Maximum values of the properties in your data set.
Process Tab 4: Analysis, Subject Market – Competing Properties tab, Filters (Continued)

c. Clicking the arrow next to the box lists the available filter types. Select the filter and appropriate boxes will show up in area (e). Filters include:
   - Filter Off
   - Less Than
   - Equal To
   - Greater Than
   - Between (See Note below)

d. Click the Apply Filters button after setting each filter and view area (a) to verify the number of properties remaining for use within the report.

e. Type in the number for high and low. Use the up and down arrows for fine tuning. If too many properties are excluded, you can widen the parameter by using the up and down arrows and click Apply Filters and all the properties are filtered based on the new criteria.

f. Click the Reset button to set all Filters to Off.

g. Displays the breakdown of the 1004 MC calculations using the included properties

Note: The number of bathrooms are currently rounded up. This issue has been reported and will be updated to reflect partial baths in a future release. For example, if the Subject Property has two and a half, 2.5 bathrooms, the chart will display 3 bathrooms.
Process Tab 4: Analysis, Subject Market – Trends tab

The charts and graphs display results for sales and listings remaining after applying filters under the Competing Properties tab.

a. Effective Date is the date used within the analysis to determine all time calculations.

b. Check this box to treat Pending Sales as Settled Sales.

c. Sets the option to calculate trend lines shown in area (g):
   - Previous 12 months
   - Previous 6 months
   - Previous 3 months
   - Hide Trend Lines

d. Determines the tipping point for switching the bubble indicator from stable to increasing or decreasing. For example: Setting the percentage to less than 5% would show -4.99% to 4.99% as stable.

e. Rate and % change based on the time period of the trend line in area (b).

f. Subject Market Trends radio buttons are initially set based on the calculations as shown in area (d) within the limits set in area (c). The radio buttons can be manually changed by the appraiser. The results will be forwarded to the 1004MC report page.

g. A graph is shown for each line of the chart above. The Trend Lines are shown as set in area (b) (calculated by previous 12 month, 6 month and 3 month trends). Use the scroll bar at the right of the window to scroll down to view all of the charts.

h. You may opt to turn off Trend Lines as this may help to make the chart less cluttered. This has no impact on the period covered by the Trend Line as set in area (b) or the calculations shown in area (d).

i. The 1004MC chart calculations are shown at the bottom of the window.

Note: Selecting “Hide Trend Lines” defaults to showing the Rate and % Change in area (b) to a 12 month period. The Rate and % Change are NOT displayed within the report and are provided to assist you in determining Market Trends.
Process Tab 4: Analysis – Adjustments tab

All of the Adjustments, with the exception of the Time Adjustment, displayed on this window are “For Reference Only.” You may enter the adjustment amounts you intend to use within the appraisal for future reference. As the Time Adjustment is a unique adjustment, it will be covered separately on the next page.

a. A Check Mark in this column indicates the adjustment is Active and will be used in the comparison grid (future enhancement).

b. The per-unit amount is entered/shown in the Adjustment Factor column.

c. The Only If Greater Than field allows you to enter a difference that must be exceeded for the adjustment to occur.

For example: The adjustment of $50 per sq. ft. only if GLA is greater than 100 sq. ft.

- 0 to 100 sq. ft. +/-, no adjustment for this difference.
- 101 sq. ft. would +/-, $50 per sq. ft. x 101 sq. ft. = $5,050.
- The adjustment starts at 1, once the difference criteria is met.

d. If the Use Regression Factor checkbox is selected, the Most Likely Value adjustment from Regression will show a check mark in the box under (a) and the Most Likely Value will show in the Adjustment Factor field (b). If the Regression Analysis is further edited, the Regression Factors’ Most Likely Value will change to reflect the updated Regression Analysis.

e. The color coded squares also indicate the confidence level of the p-value:

- Green is good
- Yellow is fair
- Red is low
Process Tab 4: Analysis, Adjustments tab – Time Adjustments

All of the Adjustments, with the exception of the Time Adjustment, displayed on this window are “For Reference Only”. You may enter the adjustment amounts you intend to use within the appraisal for future reference.

The Time Adjustment has been expanded to provide four different options.

Click the Radio button in front of the Time Adjustment option. Resulting adjustments for the first six comps will be displayed on page four, Market Adjustment Factors. Check the radio button in front of one of the options. The amount of the monthly adjustment is shown in box a and the Checkbox is checked to indicate it is an active adjustment.

b. Appraiser Defined Adjustment: Entering a monthly dollar adjustment amount in the empty box b will set the monthly adjustment in a.
c. Regression Results Adjustment: Selects the monthly regression dollar adjustment shown in c as the monthly adjustment in a.
d. Sales Price Trend line: Selects the dollar adjustment in d as the monthly adjustment in a.
Graph is shown. The amount is calculated by taking the difference between the beginning and end of the previous 12-months and dividing the difference by 12.
e. Monthly Difference in Median Sale Prices: Using the sales comparables within the selected market, the percentage difference between the Median Sale Price of the month of the Effective Date and the Sale Date is used to determine an adjustment amount for each month. The month of the sale of the selected comparable determines the adjustment percentage (use caution when using this option with small samples as the recommended monthly adjustments will vary dramatically).
Process Tab 5: Value Indicators

This grid provides you with a visual of the Value Estimate you entered into field A with the values derived from the regression analysis. Zillow and other valuation indicators may be available in future releases.

The information recorded here is for your records and is not part of the final report. It is backup data for your work file in the event some aspect of the appraisal report is questioned. Below is information on how the Appraiser’s Value Estimate was determined.

The charts on the right of the screen, compares your Value Estimate against the distribution of Sales and Listing prices included in the analysis. The subject property is represented by the Green bar, on the chart.

a. Enter estimated value of property and click Add to Charts.
b. Graph displays the Appraisers Estimated Value and compares it to the Regression Analysis value and Zillow if available. The Market Range end points, High to Low, are also displayed.
c. Charts display the subject property in relation to the overall market distribution.
Process Tab 6: Reports

The Reports tab is where all the pages of the Redstone Analysis are displayed. The following menu bar options are provided:

- The size of the page display can be increased or decreased using the up and down arrows to the right of the percentage display.
- Maps will load automatically each time the Report tab is accessed. Select Manually Build Maps to manually create maps before transferring the analysis by clicking the button above each map.
- Map Labels (optional) are accessed by clicking on the icon.

Analysis Pages Include:

1. The Market Area statistics report page contains all the sales and listing information displayed under the Analysis – Overall Market tab.
3. The Comparable Sales Selection report page contains the Feature Ratings, Filters and Comparables selected under the Analysis – Comp Selection tab.
4. The Market Adjustment Factors report page contains:
   a. Regression and Adjustment Values from the Analysis – Regression tab.
   b. Comparable Time Adjustments from the Analysis Trends tab.
      - Regression Components of Value as defined by the appraiser, are included in the report.
5. The 1004MC report page contains the information from the Analysis – Subject Market - Trends tab.
   a. Information is from Analysis – Subject Market – Trends.
   b. The text narrative is created using the Information from Analysis – Subject Market – Trends.
a. **Redstone** automatically presents the map on the page. If you need to edit it, click the **Create Map** button to bring up an area map. Control keys are provided to position, zoom in and out.
Page 2: Market Characteristics

**MARTK CHARACTERISTICS**

**Borrower:** Emo Boyer  
**Property Address:** 1367 Echo Valley Dr  
**City:** San Jose  
**County:** SANTA CLARA  
**State:** CA  
**Zip Code:** 95120  
**Lender/Client:** Mainstreet Bank  
**Address:** 12345 Mainstreet Middleton, OH 45487

### Sales Characteristics

- **Sales Price**
  - Min: 705,000  
  - Predom: 1,122,000  
  - Max: 4,000,000

- **Age**
  - Min: 0  
  - Predom: 44  
  - Max: 65

- **GLA**
  - Min: 1,104  
  - Predom: 2,100  
  - Max: 9,404

- **Site Area**
  - Min: 3,334  
  - Predom: 8,000  
  - Max: 137,550

### Listings Characteristics

- **Listing Price**
  - Min: 890,000  
  - Predom: 1,230,000  
  - Max: 4,200,000

- **Age**
  - Min: 2  
  - Predom: 45  
  - Max: 58

- **GLA**
  - Min: 1,350  
  - Predom: 2,200  
  - Max: 9,025

- **Site Area**
  - Min: 4,659  
  - Predom: 8,300  
  - Max: 138,085
Page 3: Comparable Sales Selection

Under Top Sales Analyzed, you’ll see the properties that you selected as your Sales comparables as well as other properties that you reviewed, but did not select as a comparable. The properties appear in ranked order up to a total of 20 properties. This page shows the methodology by which the comps were selected.

Also, you may comment as to why you did/did not select a particular property as a comparable, in the Comments field. To save a comment for future use, input the comment, right click in the field and choose Save as Response.

Redstone automatically presents the map on the page. If you need to edit it, click the Create Map button to bring up an area map. Control keys are provided to position, zoom in and out.
Market Adjustment Factors

A regression analysis was performed on the properties within the subject's market. A summary of the analysis is described below along with the property characteristics and their corresponding p-values. When evaluating a p-value, an amount closer to 0.0000 is more reliable than a score closer to 0.9999. The final determination of the adjustment factors used in the Sales Comparison Approach were based on the results of the regression analysis and the appraiser’s experience and knowledge of the local market.

Regression Analysis Results

<table>
<thead>
<tr>
<th># of Properties (Sample Size)</th>
<th>191</th>
</tr>
</thead>
<tbody>
<tr>
<td>R Squared</td>
<td>85.95%</td>
</tr>
<tr>
<td>Standard Error</td>
<td>6.96%</td>
</tr>
</tbody>
</table>

The R-Squared value of 85.95% indicates that 86 percent of the variation between sale prices in the market can be explained by the regression model. In general, the higher the R-Squared, the better the model fits the data. Following are the significant property characteristics selected by the appraiser:

Adjustment Factors by Regression Analysis

<table>
<thead>
<tr>
<th>Property Characteristic</th>
<th>Most Likely Value</th>
<th>Value Range</th>
<th>Units</th>
<th>R-Value</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Living Area</td>
<td>204</td>
<td>200 - 300</td>
<td>$/sqft</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Bathroom</td>
<td>96.57</td>
<td>72.16 - 121.021</td>
<td>$/rooms</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Site Area</td>
<td>10.39</td>
<td>8.79 - 11.99</td>
<td>$/sqft</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Sale Date</td>
<td>431</td>
<td>719 - 542</td>
<td>$/days</td>
<td>0.0000</td>
<td></td>
</tr>
</tbody>
</table>

Time Adjustment Factors

<table>
<thead>
<tr>
<th>Comparable No.</th>
<th>Comp #1</th>
<th>Comp #2</th>
<th>Comp #3</th>
<th>Comp #4</th>
<th>Comp #5</th>
<th>Comp #6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sale Price</td>
<td>1,485,000</td>
<td>1,385,000</td>
<td>1,450,000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sale Date</td>
<td>3/13/2015</td>
<td>5/22/2015</td>
<td>4/15/2015</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Adjustment Percent</td>
<td>3.03%</td>
<td>0.1%</td>
<td>0.1%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Adjustment Factor</td>
<td>45,000</td>
<td>0</td>
<td>30,000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Time Adjustment Percentage by Month for the Last 12 Months

[Graph showing time adjustment percentage by month for the last 12 months]
Market Conditions Addendum to the Appraisal Report

Appraiser:

Property Address: 1357 Echo Valley Dr, City: San Jose, State: CA, ZIP Code: 95120

Buyer:

Instructions: The appraiser must use the information required on this form as the basis for his/her conclusions and must provide support for those conclusions regarding housing trends and overall market conditions as reported in the Neighborhood section of the appraisal report form. The appraiser must fill all the information to the extent it is available and relative and must provide analysis as indicated below. If any required data is unavailable or is considered unreliable, the appraiser must provide an explanation. It is recognized that not all data sources will be able to provide data for the periods above. If it is available, the appraiser must include that data in the analysis. If data sources provide all the required information as an average instead of the median, the appraiser should report the available figure and clarify it as an average. Sales and listings must be properties that correlate with the subject property, determined by applying the criteria that would be used by a prospective buyer of the subject property. The appraiser must explain any anomalies in the data, such as seasonal listing, price, construction, setback, etc.

Inventory Analysis:

<table>
<thead>
<tr>
<th>Period</th>
<th>Prior 2 Months</th>
<th>Prior 4 Months</th>
<th>Current 3 Months</th>
<th>Overall Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total # of Comparable Sales (Listed)</td>
<td>17</td>
<td>11</td>
<td>23</td>
<td>X</td>
</tr>
<tr>
<td>Absorption Rate (Total Sales/Month)</td>
<td>2.83</td>
<td>3.97</td>
<td>7.67</td>
<td>X</td>
</tr>
<tr>
<td>Total # of Comparable Active Listings</td>
<td>6</td>
<td>13</td>
<td>17</td>
<td>X</td>
</tr>
<tr>
<td>Months of Housing Supply (Total Listings/Month)</td>
<td>2.12</td>
<td>3.55</td>
<td>2.22</td>
<td>X</td>
</tr>
</tbody>
</table>

Median Sales & List Price:

<table>
<thead>
<tr>
<th>Period</th>
<th>Prior 2 Months</th>
<th>Prior 4 Months</th>
<th>Current 3 Months</th>
<th>Overall Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Median Comparable Sales Price</td>
<td>$1,200,000</td>
<td>$1,450,000</td>
<td>$1,360,000</td>
<td>X</td>
</tr>
<tr>
<td>Median Comparable Days on Market</td>
<td>84</td>
<td>38</td>
<td>38</td>
<td>X</td>
</tr>
<tr>
<td>Median Sales Price as % of List Price</td>
<td>76</td>
<td>21</td>
<td>22</td>
<td>X</td>
</tr>
</tbody>
</table>

Are foreclosures sales (FEO sales) a factor in the market? Yes No
If yes, explain the number of FEO listings and evaluate trends in listings and sales of foreclosed properties.

Market Research & Analysis:

There were a total of 21 Comparable Sold Sales in the past 12 months.
The Median Sales Price for the prior 7-12 months was $1,200,000 and for the current to prior 3 months is $1,360,000.
The Median Days on Market for the prior 7-12 months was 84 and 38 for the current to prior 3 month period.
The statistics above were generated from an exported MLS market search.

Summary the above trends and address the impact on the subject unit and project.

Appraiser:

Signature

Appraiser Name: Neil Forrest
Company Name: AppraisalWorld
Address: 303 Piercy Rd, San Jose, CA 95138
Date: CA 95138
Email Address: nlf@appraisalworld.com
Transferring Redstone Analysis into your 1004 or 2055 as Addendum Pages

**ClickFORMS Users**

It is recommended to start your 1004 or 2055 report in Redstone and then transfer into a blank template or clone. Make sure you have the latest ClickFORMS version (v8.7.5).

**ClickFORMS users:**

Follow the processes below to transfer the analysis to your 1004 and 2055 reports:

- Within **Redstone**, **Save** the Redstone Analysis before using **Copy**.
- Select the **Edit > Copy Redstone Analysis** function.
- Open **ClickFORMS**.
- Select the **Edit> Paste Redstone Analysis** function to complete the transfer.
Other Appraisal software: (PDF Creation)

Follow the processes below to transfer the analysis to your 1004 and 2055 reports.

- Click **File > Create Adobe PDF** function
- In the Create Adobe PDF File window select the report pages you want to include in your analysis addendum.
- Import the PDF file into your 1004 or 2055 report as addendum pages using your software providers PDF import instructions.
- The PDF file is stored in the Libraries>Documents>My Redstone>PDF files folder.
Redstone Files and Where They Are Stored
The primary Redstone files you will need to access are stored in the following folders:

![Redstone Files Diagram]

a. The **My Redstone** file folder is located under Libraries>Documents>My Redstone
   - This is the default folder for the **MLS import tool**
   - Once the MLS data has been imported into Redstone, you will see a prompt asking you if you want to **move MLS export data file to the archive folder**
   - Click Yes and the file will be moved to the newly created MLS Archive folder.
   - Following this process minimizes the risk of an old file accidently being re-used.

b. It is recommended to place the MLS export files into the **MLS Imports** folder
   - This is the default folder for the **MLS import tool**
   - Once the MLS data has been imported into Redstone, you will see a prompt asking you if you want to move MLS export data file to the archive folder
   - Click Yes and the file will be moved to the newly created MLS Archive folder.
   - Following this process minimizes the risk of an old file accidently being re-used.

c. **PDF Files of Redstone Reports** are saved to this default file folder

d. **Redstone Reports (.REDX file format)** are automatically saved to this default file folder. This report file is your electronic work file. The **Backup** folder is also located in the **Reports** folder. Here you’ll find your Backup files (.bak) in the event that you need to restore a file.

e. The **User License file(s)** are stored in this file folder
DEFINITION OF STATISTICAL TERMS

Definitions

DEFINITION OF R-SQUARED (Coefficient of Determination): In regression analysis, a measure of the strength of the relationship between the independent variables and the dependent variable. The measure ranges from 0 to 1 - the higher the number, the stronger the relationship (0 would indicate no relationship)

DEFINITION OF ADJUSTED R-SQUARED: R-Squared can overstate the goodness of fit in a model when insignificant variables are included, or the number of variables R-Squared appropriately.

DEFINITION OF P-VALUE: A particular statistic that measures the significance of a variable in a regression analysis. The statistic is important in inferential statistics for hypothesis testing in regression analysis. The P-Value is a measure of the randomness of a component used in the regression analysis.

DEFINITION OF COV (Coefficient of Variation): A standard statistical measure of the relative dispersion of the sample data about the mean of the data; the standard deviation expressed as a percentage of the mean.

DEFINITION OF COD (Coefficient of Dispersion): The average deviation of a group of numbers from the median expressed as a percentage of the median.

DEFINITION OF STANDARD ERROR: A measure of the precision of a measure of central tendency, the smaller the standard error, the more reliable the measure of standard tendency. In regression analysis, the standard deviation of a regression coefficient, the smaller the standard error relative to the coefficient, the more reliable the coefficient.

DEFINITION OF SALES RATIO: A measure of model accuracy that divides predicted values by sales prices. The closer to 1 that a sales ratio is, the better the model's predictive capabilities

DEFINITION OF STANDARD DEVIATION: The statistic calculated from a set number by subtracting the mean from each value and squaring the remainders, adding together all of the squares, dividing by the size of the sample less one, and taking the square root of the result. When the data are normally distributed, one can calculate the percentage of observations within any number of standard deviations of the mean from normal probability tables.

Sources Documents

The Collateral Valuation Report (CVR) has been designed in conformance with all available technology, data and statistical processes, generally accepted to represent the state of industry, including:

Uniform Standards of Professional Appraisal Practice (USPAP):
Standard 1
Standard 2

Since specialized statistical and mass appraisal information is contained with Standard 6 and Advisory Opinion 18, these sources have also been considered in tandem with the Development and Reporting standards contained within Standard 1 and Standard 2. It is expressly understood that the Collateral Valuation Report is a summmary appraisal report performed under the guidance of Standards 1 and 2 as noted above.

Joint Industry Task Force on Automated Valuation Models:
Standards and Testing Guidelines
These standards and guidelines are instructive in the method of testing accuracy and identifies the statistics and outcome guidelines that can be relied upon in performance of statistical analysis.

International Association of Assessing Officers:
Standard on Ratio Studies
Mass Appraisal of Real Property
Standard on Automated Valuation Models

Appraisal Institute:
A Guide to Appraisal Valuation Modeling
Practical Applications in Appraisal Valuation Modeling and Design
The 13th Edition of the Appraisal of Real Estate

Visual Valuation: Implementing Valuation Modeling and Geographic Information Systems

These texts form the body of knowledge that helps provide an understanding of the modeling process and the use of statistics in real estate.

The Modeling Process

An acceptable model will have both reasonable coefficients and satisfactory outcome statistics. The appraiser has been trained in a manner sufficient to understand the various statistical measures outlined in this report. The statistical measures defined within this analysis allow the appraiser to understand the data and draw certain conclusions based on the accuracy of the data, the amount and quality of the data, and the measures of statistical significance and accuracy of the analysis applied.

Competence

The appraiser completing the Collateral Valuation Report asserts that they have undergone sufficient training, and further, have an understanding of the statistical measures underlying the regression component of the process to generally understand the method and manner of analysis. The appraiser does not assert that they are statisticians. They are, however, aware of the basic guidelines pertaining to the use of CVR application as a tool to analyze small market datasets, and as such, are capable of understanding the analysis and methodology in a manner sufficient to render a credible estimate of value in tandem with the other data and analysis present in the report.

The final value conclusion is the appraiser's own, and is based on the appraiser's knowledge and experience in the field of appraisal. The data and analysis in this report, whether through direct information or through derived statistical information, aids the appraiser in understanding the dynamics of the neighborhood and market area.
Redstone Automatically Completes Your 1004MC Report

1004MC Automatically Filled in. The Choice is Yours.
With all the data that Redstone has pulled on the market, it’s an easy task for it to complete your 1004MC addendum. We did not include this familiar addendum with the sample Redstone you’re holding, but you can choose to have Redstone output a completed 1004MC to include with your report.

Attach the Redstone Addenda PDF to Any Report, Produced From Any Appraisal Software Vendor.
Redstone addenda are exported as a PDF file that can be attached to any appraisal report generated from any appraisal software application. ClickFORMS users can copy and paste the addendum into their report.

Add Redstone to give your report the analytical credibility that’s missing from a traditional 1004
Are reviewers questioning your credibility more and more? Are you wasting time justifying your adjustments and comps to prove you’re the valuation expert? Add a Redstone analysis to your report and watch reviewers and clients take notice and begin to trust your judgment instead of second guessing it. Avoid costly call backs with Redstone.

Try Redstone Appraisal Analytics Special 10 Analyses for $10
This is a great starter pack to see if Redstone is right for you. After you have tried the sample properties that are built into Redstone, work with Redstone in your local market with your local data. This discount will give you 10 analyses to try Redstone with data you know and will be using in your reports. Purchase directly from the AppraisalWorld.com store or call your sales representative at 800-622-8727.

For more information on Redstone, including a step-by-step demonstration video:

www.bradfordsoftware.com/redstone